Water Pollution Control Compliance on Construction Sites for Resident Engineers
Why Are You Here?

- To improve your skills as an RE as they relate to Water Pollution Control on Construction Sites
- To learn who the important players are and how they can assist you
- To learn what your responsibilities are - before, during, and after construction
Introduction

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities
Introduction

Water Pollution Prevention

⇒ Overall Purpose
  ⇒ To Reduce Potential Environmental and Human Health Impacts
  ⇒ Comply with State and Federal Laws
Introduction

Construction site erosion can cause impacts to the environment greater than nature’s own erosion process.
Sediment, the most common pollutant washed from construction sites, clogs the gills of fish, blocks light transmission and increases ocean water temperature .....harming aquatic life, and disturbing the food chain.
Introduction

Construction Site Water Pollution Prevention

Minimize the Potential Impact that Construction Activities may have on Water Bodies and Protect their Beneficial Uses for Future Generations
Introduction

- Clean Water Act
- Permit CAS000003, Caltrans Statewide Municipal
- Permit CAS000002, General Construction Activities
- Caltrans Statewide Storm Water Management Plan (SWMP)
Role of the Players

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities
  Before Construction
⇒ RE Responsibilities
  During Construction
⇒ Project Closeout Responsibilities
Role Of The Players

Figure 2-1
Functional Organization Chart for the Storm Water Program
Role Of The Players

- District Construction Division
  Players
    ⇒ Construction Division Chief
    ⇒ Construction Storm Water Coordinator (CSWC)
    ⇒ Resident Engineer (RE)
    ⇒ Contractor

- District NPDES
  Storm Water Coordinator
Construction Division Chief’s Role

- Implementation of policies, procedures, personnel and equipment.
- Includes ensuring compliance with all elements of the SWMP for entire Construction Division.
Construction Storm Water Coordinator’s Role

- CSWC conducts inspections to assist the RE with water pollution control compliance.
- Assist the RE reviewing the SWPPP/WPCP for adequacy.
Resident Engineer’s Role

- Administers construction contracts.
- Responsible for ensuring water pollution control compliance for the contract.
- Approves SWPPP/WPCP.
- Conducts Inspections.
- Oversees contractor self-monitoring.
- Forwarding non-compliance documentation.
- Maintaining documentation.
- Impose sanctions for non-compliance of the contract.
Contractor’s Role

- Carry out the contract per the plans, specifications and permits.
- Develop and implement water pollution control elements, including:
  - Preparation of a SWPPP/WPCP.
  - Inspection and maintenance of BMPs.
  - Construction of permanent BMPs.
  - Completion of the Annual Compliance Certification.
District NPDES Storm Water Coordinator’s Role

 öz Liaison with the Water Quality Program.
öz Liaison activities include:
  ⇒ Conduct meetings relating to storm water management issues with other District Coordinators and MS4 permittees.
  ⇒ Communications with the RWQCB representatives.
  ⇒ Assist the District Divisions.
Management Tools

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities
Permits

General Construction Permit CAS000002 - The ‘02 permit
Caltrans NPDES Permit CAS000003 - The ‘03 permit

⇒ The 03 Permit requires that Caltrans’ construction program complies with the General Construction Activity Permit for construction sites that disturb 5 acres or more
⇒ Both permits can be viewed and downloaded from the State Water Resources Control Board website, www.swrcb.ca.gov
Specifications

Caltrans Standard Specifications, Section 7-1.01G

⇒ Requires contractors to prepare and implement a program to control water pollution effectively during the construction of all projects.

⇒ SWPPP/WPCP and BMPs must meet requirements of this section

Sections 10, 16, 18, and 20
Contract Special Provisions

Contract Special Provisions - Section 10
**Manuals**

**Caltrans Storm Water Quality Handbooks**
- Project Planning and Design Guide
- SWPPP / WPCP Preparation Manual
- Construction Site BMPs Manual
  - 1997 Contractors Guide

or hard copies are available from Caltrans Publications

**Revised Construction Manual**
**New BMP Field Guidance Manual**
**New Dewatering Guide**
Manuals

Caltrans Storm Water Quality Handbooks
  ⇒ Project Planning and Design Guide
  ⇒ SWPPP / WPCP Preparation Manual
  ⇒ Construction Site BMPs Manual

Revised Construction Manual

New BMP Field Guidance Manual

New Dewatering Guide
Caltrans Storm Water Quality Handbooks
- Project Planning and Design Guide
- SWPPP / WPCP Preparation Manual
- Construction Site BMPs Manual

Revised Construction Manual
New BMP Field Guidance Manual
New Dewatering Guide
Manuals

Caltrans Storm Water Quality Handbooks
⇒ Project Planning and Design Guide
⇒ SWPPP / WPCP Preparation Manual
⇒ Construction Site BMPs Manual

Revised Construction Manual
New BMP Field Guidance Manual
New Dewatering Guide
Manuals

→ Construction Site BMPs Manual
  ⇒ Guidelines for the selection and implementation of construction site BMPs
  ⇒ Major changes compared to 1997 Handbooks
    • Area requirements/Tables
    • Fiber rolls
    • Stockpile management
    • Entrances / exits
    • Dewatering
Construction Site BMPs Manual

- Major changes compared to 1997 Handbooks (cont)
  - New BMPs
  - New # system
  - Dropped BMPs
  - Revisions to soil stabilizers
  - Street sweeping
  - Gravel bag berm
Manuals

-Caltrans Storm Water Quality Handbooks
  - Project Planning and Design Guide
  - SWPPP / WPCP Preparation Manual
  - Construction Site BMPs Manual

-Revised Construction Manual
  - http://www.dot.ca.gov/hq/construc/

-New BMP Field Guidance Manual
-New Dewatering Guide
**Manuals**

- Caltrans Storm Water Quality Handbooks
  - Project Planning and Design Guide
  - SWPPP / WPCP Preparation Manual
  - Construction Site BMPs Manual
- Revised Construction Manual
- New BMP Field Guidance Manual
- New Dewatering Guide
Manuals

BMP Field Guidance Manual
⇒ “Tool Box” for field personnel
⇒ Principals of Erosion and Sediment Control
⇒ Trouble Shooting Guide
⇒ BMP Selection Installation and Maintenance
Caltrans Storm Water Quality Handbooks
- Project Planning and Design Guide
- SWPPP / WPCP Preparation Manual
- Construction Site BMPs Manual

Revised Construction Manual
New BMP Field Guidance Manual
New Dewatering Guide
Construction Storm Water Coordinator (as a tool)

In addition to already stated functions:

⇒ Assist during pre-construction meetings.
⇒ Information and training source.
⇒ Liaison with other District personnel during construction.
⇒ Liaison to Regulatory agencies.
⇒ Liaison to the NPDES Storm Water Coordinator.
Other Available Tools

- Construction Storm Water Pollution Prevention Bulletins

- Online Forum
  www.SWPPPQuestions.com

- Storm Water Task Force
RE Responsibilities Before Construction

Course Highlights
- Introduction
- Role of the Players
- Management Tools
- RE Responsibilities Before Construction
- RE Responsibilities During Construction
- Project Closeout Responsibilities
RE Responsibilities Before Construction

Course Highlights
- Introduction
- Role of the Players
- Management Tools
- RE Responsibilities Before Construction
- RE Responsibilities During Construction
- Project Closeout Responsibilities

- Review the RE Pending File
- Appoint your SWPPP Inspector
- Conduct Pre-Construction Meetings
- WPC Strategies
- Review the SWPPP/WPCP
Review the RE Pending File

- Topography Map
- Soils/Geotechnical or Project Materials Report
- Pre-Construction Storm Water Quality Control Practices
- Permanent Post-Construction Storm Water Control Measures
Review the RE Pending File

- Other Plans / Permits
- Copy of Project Drainage Report
- Construction Site Estimates
- Copy of Submitted Notification of Construction (NOC)
Review the RE Pending File

Topography Map

- Extends approximately 400 meters (quarter mile) beyond the boundaries of the construction site.
- A U.S. Geological Survey (USGS) quad map is recommended.
- Shows the construction site and water pollution control related items.
Responsibilities Before Construction

Review the RE Pending File

Soils / Geotechnical / Materials Report

- Toxic History of the Site
- The Nature of Fill Material
- Existing Data Describing the Soil

Geotechnical Investigation Report

INTERSTATE 80 IMPROVEMENTS
IN PLACER COUNTY WITHIN THE CITY OF ROSEVILLE
FROM ATLANTIC STREET OC TO TAYLOR ROAD OC

Prepared for
CITY OF ROSEVILLE
and
CALTRANS DISTRICT 3
Existing Control Practices

- Practices that are already in place to reduce sediment and other pollutants in storm water discharges.
- Examples: sedimentation ponds, oil/water separators, spill containment facilities, curb and gutter, concrete drainage systems, etc.
- Note if there are none.
Review the RE Pending File

Post-Construction Controls

⚠️ Permanent BMPs to reduce pollutants in storm water discharges.

⚠️ Includes Operation & Maintenance procedures.
Review the RE Pending File

- List of other permits or plan requirements
- Examples of other permits:
  - Army Corps of Engineers 404 permit
  - RWQCB 401 permit
  - RWQCB deminimus discharge permit
  - California Department of Fish and Game streambed alteration agreement or 1603 permit
  - Dewatering permit
Review the RE Pending File

- Drainage Report
- Typical information includes:
  - Hydrology Maps
  - Drainage Boundaries
  - Runoff Concentrations
  - Runoff Coefficients
  - Basin Sizing Calculations
  - Offsite Runoff Calculations
Review the RE Pending File

Construction Site Estimates

- An estimate of construction site area in square meters (acres)
- Runoff coefficient of construction site - before and after construction
- An estimate of impervious construction area - before and after construction

Attachment D

Computation Sheet for Determining Runoff Coefficients

Total Site Area = 171,965 m² (A)

Existing Site Conditions

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impervious Area 1</td>
<td></td>
<td>88,157 m²</td>
</tr>
<tr>
<td>Impervious Area Runoff Coefficient 2, 4</td>
<td>= 0.95 (C)</td>
<td>83,749 m²</td>
</tr>
<tr>
<td>Pervious Area 3</td>
<td></td>
<td>83,808 m²</td>
</tr>
<tr>
<td>Pervious Area Runoff Coefficient 4</td>
<td>= 0.4 (E)</td>
<td>33,523 m²</td>
</tr>
</tbody>
</table>

| Sum                  | = 117,272 m² | (B x C) + (D x E) |

Divide: 140735/171965 = 0.68 (F)

Existing Area Runoff Coefficient = 0.68 (F)

Proposed Site Conditions

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impervious Area1</td>
<td></td>
<td>100,036 m²</td>
</tr>
<tr>
<td>Impervious Area Runoff Coefficient 2, 4</td>
<td>= 0.95 (H)</td>
<td>95,034 m²</td>
</tr>
<tr>
<td>Pervious Area 3</td>
<td></td>
<td>71,929 m²</td>
</tr>
<tr>
<td>Pervious Area Runoff Coefficient 4</td>
<td>= 0.4 (J)</td>
<td>28,771 m²</td>
</tr>
</tbody>
</table>

| Sum                  | = 123,805 m² | (G x H) + (I x J) |

Divide: 123805/171965 = 0.72 (F)

Existing Area Runoff Coefficient = 0.72 (F)
Review the RE Pending File

✦ Notification of Construction (NOC)
✦ Submitted to RWQCB at least 30 days prior to construction.
✦ Equivalent to Notice Of Intent (NOI).
✦ Included information:
  ⇒ Tentative start date and duration
  ⇒ Estimate of affected acres and vicinity map
  ⇒ RE in charge and telephone number
  ⇒ Field office information and location map
What If RE Pending File is Incomplete?

- Determine whether documentation is necessary
  - Not all projects need all listed contents of a pending file
  - Whether post construction BMPs are required should come from project development. Attempt communication with responsible party to obtain missing documentation

- Call or meet with Project Development, DCSWC, Project Manager

- Obtain missing documentation from outside source
  - Contractor
  - CCO
RE Responsibilities Before Construction

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ **RE Responsibilities Before Construction**
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities

- Review the RE Pending File
- Appoint your SWPPP Inspector
- Conduct Pre-Construction Meetings
- WPC Strategies
- Review the SWPPP/WPCP
Appoint The SWPPP Inspector

Candidate qualifications:

- Construction inspection experience
- Overall project knowledge
- SWPPP inspector training
- Hydraulics or environmental engineering knowledge
- Landscape engineer
RE Responsibilities Before Construction

Course Highlights

- Introduction
- Role of the Players
- Management Tools
- **RE Responsibilities Before Construction**
- RE Responsibilities During Construction
- Project Closeout Responsibilities

- Review the RE Pending File
- Appoint your SWPPP Inspector
- Conduct Pre-Construction Meetings
- WPC Strategies
- Review the SWPPP/WPCP
Pre-Construction Meetings

- State personnel involved with the project.
- Contractor
State Personnel Meeting

**Who should attend?**

- RE
- Appointed SWPPP inspector
- Project Manager
- Project Engineer
- Environmental Engineer
- Maintenance Representative
- DCSWC
- Structures Personnel
- RWQCB Representative
Responsibilities Before Construction

State Personnel Meeting

- Discuss project-specific water pollution control issues
  - Other plans and permits
  - Environmentally sensitive areas
  - Coordination of Special Provision requirements
  - The conceptual SWPPP
  - RE Pending File information
  - More????
Contractor Meeting

Who should attend?

- RE
- Contractor’s Superintendent
- Contractor’s Water Pollution Control Manager (WPCM)
- Appointed SWPPP Inspector
- DCSWC
- RWQCB Representative (New)

Can be integrated into the typical pre-construction meeting with the contractor.
Contractor Meeting

Discuss project-specific water pollution control issues.
- Other plans and permits,
- Environmentally sensitive areas,
- Coordination of Special Provision requirements,
- The conceptual SWPPP,
- RE Pending File information,
Who Wants To Be A Millionaire?
Millionaire Review Question #1

Permit CAS000003, regulates storm water discharges from?

A) Construction sites that disturb over 5 acres
B) Industrial activities
C) General construction activities
D) Caltran’s properties, facilities, and activities
Which of the following is not a new SWPPP requirement?

A) Runon Calcs
B) Schedule
C) Construction site estimates
D) Training for contractors
Millionaire Review Question #3

Which manual(s) will assist RE’s in the process of reviewing a contractor’s SWPPP?

A) Construction site BMP manual
B) SWPPP / WPCP preparation manual
C) SWPPP / WPCP review manual
D) B and C
Millionaire Review Question #4

Which of the following documents will **not** be found in the RE Pending File?

A) Topography map
B) Construction site estimates
C) List of other permits
D) Area requirements/tables
Millionaire Review Question #5

The Notification of Construction (NOC) should be submitted when? - and to whom?

A) 20 days prior to the rainy season - SWRQCB
C) Prior to submission of NOI - EPA
D) 30 days prior to construction - SWRQCB
Millionaire Review Question #6

It’s required to invite a representative from the RWQCB to attend which meeting?

A) State personnel pre-con mtg
B) Const. progress mtg
C) Contractor pre-con mtg
D) Discharge review mtg
RE Responsibilities Before Construction

Course Highlights

- Introduction
- Recent Fines
- Role of the Players
- Management Tools
- **RE Responsibilities Before Construction**
- RE Responsibilities During Construction
- Project Closeout Responsibilities

- Review the RE Pending File
- Appoint your SWPPP Inspector
- Conduct Pre-Construction Meetings
- WPC Strategies
- Review the SWPPP/WPCP
Water Pollution Control Strategies

- Prevent storm water contact with the construction site
- Protect disturbed soil areas (DSAs) from erosion
- Minimize sediment in storm water before discharge
- Prevent storm water contact with other pollutants
- Prevent non-storm water discharges
Prevent Storm Water Contact With The Construction Site

- Storm water from the sky - Rainfall
- Storm Water from adjacent areas - Run-on
A BMP that is practicable to protect DSAs from rainfall is:

⇒ Scheduling
Prevent Storm Water Contact With The Construction Site

A BMP that is practicable to protect DSAs from run-on is:

- Earth dikes/drainage swales
Protect Disturbed Soil Areas From Erosion

BMPs to protect DSAs from erosion are:

⇒ Temporary soil stabilization
⇒ Top of slope dikes
⇒ Slope drains
⇒ Gravel bag berms or fiber rolls
Minimize Sediment In Storm Water Before Discharge

- **Sediment Barriers**
  - Silt Fence
  - Sandbag barrier
  - Straw bale barrier

- **Desilting Basins / Sediment Traps**
Prevent Storm Water Contact With Other Pollutants

- Minimize storage and non-essential activities
- Store materials/wastes in watertight containers
- Cover stored materials/wastes
- Prevent run-on
- Clean up spills of materials/wastes
Prevent Non-Storm Water Discharges

- Paving and concrete waste
- Dewatering operations
- Vehicle and Equipment Cleaning, Fueling, maintenance
- Sanitary/septic waste
- Runoff from dust control
- Materials or chemicals leaks, spills
Contract Documents

- Standard Specifications
- Contract Special Provisions
- Project Plans
Standard Specifications

- Section 7-1.01G, Water Pollution
- Section 10, Dust Control
- Section 16, Clearing and Grubbing
- Section 18, Dust Palliative
- Section 20, Erosion Control and Highway Planting
Section 10-1. Water Pollution Control

- Issued to satisfy the NPDES Permit requirements
- Requires use of the Storm Water Quality Handbooks
- Details water pollution control requirements
Contract Special Provisions

Contents of Water Pollution Control Specifications

- Identifies plan required (SWPPP or WPCP)
- Identifies appropriate RWQCB
- The SWPPP/WPCP contents and approval process
- Additional required BMPs
- Identifies cost breakdown requirements
- Year round requirements
Contract Special Provisions

Contents of Water Pollution Control Specs. (Cont.)

⇒ Defines active and non-active Disturbed Soil Areas (DSAs)
⇒ Defines the rainy and non-rainy seasons
⇒ Defines maximum active DSAs during the rainy season
⇒ Inspection and maintenance requirements
⇒ Move-In/Out (Permanent Erosion Control) (New)
⇒ 50/50 BMP Maintenance sharing (New)
⇒ Progress Payments/Detention/Retention
Project Plans

- Conduct review of plans in context of water pollution control Specifications
  - General layout
  - Existing drainage courses
  - Facility being constructed or modified
  - Staging of project
  - Possible desilting basin locations
Using the SWPPP/WPCP Preparation Manual

- Appropriate SWPPP and WPCP Preparation Manual Identified in the SSP
  - OLD: The 1997 Contractor’s Guide and Specifications
  - NEW: 2000 SWPPP and WPCP Preparation Manual
- Enlist CSWC assistance for review as necessary

Get Manuals online at http://www.dot.ca.gov/hq/construc/stormwater.html or hard copies are available from Caltrans Publications
Projects Under Old Special Provisions

If your Contract Special Provisions reference the 1997 storm water quality handbooks:

- Guidelines to assist districts in writing a CCO to comply with new NPDES permits. (CPD 00-12 and 00-12.1)
- CCO required for all on-going SWPPP construction projects
- WPCP projects do not require CCO at this time
Projects Under Old Special Provisions

⇒ CCO Guidelines
  ⇒ Checklist references the relevant NPDES permit requirements and the Storm Water Handbook sections
  ⇒ Guidelines and checklist available on the Construction Program’s Intranet site: http://roadware.dot.ca.gov or from your CSWC
Caltrans Storm Water Quality Handbooks

Construction Site BMPs Manual

- Know and understand this manual

Get Manuals online at http://www.dot.ca.gov/hq/construc/stormwater.html

or hard copies are available from Caltrans Publications
RE Responsibilities Before Construction

Course Highlights

⇒ Introduction
⇒ Recent Fines
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout

- Review the RE Pending File
- Appoint your SWPPP Inspector
- Conduct Pre-Construction Meetings
- WPC Strategies
- Review the SWPPP/WPCP
Using the SWPPP/WPCP Preparation Manual

- Let’s review a SWPPP
- Use the Manual
How is the Manual set up?

Each Section has:

- **INSTRUCTIONS** .... Telling you what is necessary in that section
- **REQUIRED TEXT** .... Telling the contractor exactly what verbiage to use in the document

Some sections have:

- **EXAMPLES** ..... Showing you what the section might include
Section 2, page 7 of 62 of Prep Manual

Required information

⇒ Storm Water Pollution Prevention Plan
⇒ Construction Project Name
⇒ Caltrans Contract Number
⇒ Identification of Lead Agency (Caltrans or Local Agency)
⇒ Contractors Name, Address, Telephone Number, and Contact Person
Title page (continued)

⇒ Job Site Address and Telephone Number (if any)
⇒ Name of Contractors Water Pollution Control Manager (WPCM)
⇒ Name of Company that Prepared the SWPPP
⇒ SWPPP Preparation Date
Table of Contents

- Preparation Manual page 9 of 62
- Include the Number and Names for each section
- List page number for each subsection
- Include a Tab for each Major Section and Attachments
Section 100

- Preparation Manual page 11 of 62
- SWPPP Certification and Approval
  - 100.1 Initial SWPPP Certification
  - 100.2 SWPPP Approval
  - 100.3 Annual Compliance Certification
SWPPP Certification and Approval

100.1 Initial SWPPP Certification
- Required Text
- Project Name
- Caltrans Contract Number
- Contractors signature, Name, Title, Date, and telephone number
- Submitted to the RE for review and approval

100.2 SWPPP Approval
- Required Text
- RE signature and name
- Telephone number
- Date signed
100.3 Annual Compliance Certification

⇒ Preparation Manual page 14 of 62
⇒ Required text for this section
⇒ Prepared by qualified person
  • List persons name and contact number in the SWPPP
⇒ Completed by June 15th
  • Job starting on or after June 15th require certification on the following June 15th
⇒ Keep completed and signed copies of the annual compliance certification in this section
⇒ Include blank copies of forms in Attachment M
Section 200

⇒ SWPPP Preparation Manual page 15 of 62
⇒ SWPPP Amendments
  ⇒ 200.1 SWPPP Amendment Certification and Approval
  ⇒ 200.2 Amendment Log
Required Text

SWPPP shall be Amended when:

⇒ Changes in construction or operations which may affect the discharge of pollutants to surface waters, ground water, or municipal separate storm sewer system
⇒ If any conditions of the Permit are violated
⇒ General objective of reducing or eliminating pollutants in storm water discharges has not been achieved
⇒ If the RWQCB determines that a Permit violation has occurred
  • Changes implemented in 14 days
⇒ When required by the Special Provisions
⇒ When deemed necessary by the RE
200.2 Amendment Log

⇒ Required text for the log:
  ⇒ Project Name
  ⇒ Caltrans Contract Number
  ⇒ Amendment Number
  ⇒ Date
  ⇒ Brief description of Amendment
  ⇒ Prepared By
Section 300

Page 20 of 62 of the Manual

Introduction and Project Description

⇒ 300.1 Introduction and Project Description
⇒ 300.2 Unique Site Features
⇒ 300.3 Project Schedule/Water Pollution Control Schedule
⇒ 300.4 Construction Site Estimates
⇒ 300.5 Contact Information/List of Responsible Parties
**300.1 Introduction and Project Description**
- Provide legal description of the project
- Proximity to receiving waters
- Identify who owns the drainage system

**300.2 Unique Site Features**
- Provide a brief description of unique features
- Significant or high-risk construction activities
- Include any features or activities within or adjacent to water bodies
300.3

Construction Site Estimates

⇒ Required text
⇒ Construction site area
⇒ Runoff coefficient before and after construction
  • Include calculations in Attachment D
⇒ Percentage impervious area before and after construction
⇒ Anticipated storm water run-on calculations
  • Include calculations in Attachment E
SWPPP Attachments

Attachement D

⇒ Computation Sheet for determining Runoff Coefficients
  • Determines the amount of runoff before and after construction
SWPPP Attachments

➡️ **Attachment E**

➡️ Calculation for Storm Water Run-on

- Determines the amount of anticipate storm water run-on
- Helps in designing temporary BMPs to control erosion
300.4

Page 22 of 62 of the SWPPP Preparation Manual

Project Schedule / Water Pollution Control Schedule

⇒ Written or graphical schedule
  • Show how the rainy season relates to soil disturbing and re-stabilization activities

⇒ Adequate details for major activities sequenced with implementation of BMPs
  • Project start and finish dates
  • Rainy seasons dates
  • Annual certification
  • Mobilization dates
  • Mass clearing and grubbing/road side clearing dates
  • Major grading/excavation dates
  • Special dates in other permits (Army Corp, Fish and game)
⇒ **Project Schedule**

⇒ Adequate details for major activities sequenced with implementation of BMPs (continued)

- Annual submittal of rainy season implementation -if Required (New)
- Pre-rainy season temporary soil stabilization or Sediment control BMPS (if Required by the Special Provisions)
- Rainy season implementation schedule for soil stabilization, sediment controls, wind erosion controls, tracking controls, non-storm water, waste management and materials BMPs
- Non-rainy season implementation schedule of same
300.4

Project Schedule

⇒ Adequate details for major activities sequenced with implementation of BMPs (continued)

• Pavement operations
• Major planned stockpiling operations
• Non-storm water discharges, dewatering or grinding operations
• Final stabilization activities (staged)
• See page 25 and 26 of SWPPP Prep Manual (11x17 foldout)
300.5

Page 27 of 62 of the Manual

Required text

Contact Information/List of Responsible Parties

⇒ List contractors person(s) responsible for water pollution controls during construction

• Name, address, and telephone number
Water Pollution Control Manager (WPCM) duties

- Ensuring full compliance with the SWPPP and Permit
- Implementation of erosion and sediment control measures
- Implement all non storm water, materials and waste management activities
- Storm event inspections
- Preparing annual compliance certification
- Ensuring elimination of all unauthorized discharges
- Authority to mobilize crews for immediate repairs
- Coordinate with the RE
References

⇒ Page 29 of 62 of the SWPPP Preparation Manual
⇒ Required text
⇒ Identify all Documents Referenced in the SWPPP
  • Project Plans and Specifications
  • NPDES permits
  • Other permits Army Corp, DF&G, DTSC ADL variance, etc.
  • Handbooks, references, manuals, guidance
  • Project reports: geotechnical, soils, materials, drainage
  • Include complete reference name, number, author, date, and revision dates that apply
⇒ All referenced materials not attached to SWPPP must be kept on-site and be readily available for review
Section 500 Body of SWPPP

- 500.1 Objectives
- 500.2 Vicinity Map
- 500.3 Pollutant Source Identification and BMP Selection
- 500.4 Water Pollution Control Drawings
- 500.5 Construction BMP Maintenance, Inspection and Repair
- 500.6 Post-Construction Storm Water Management
- 500.7 Training
- 500.8 List of Subcontractors
- 500.9 Other Plans or Permits
Objectives

- Identify all pollutant sources, including sources of sediment that may affect the quality of storm water discharges associated with construction activities from the construction site
- Identify non-storm water discharges
- Identify, construct, implement in accordance with a time schedule, and maintain Best Management Practices (BMPs) to reduce or eliminate pollutants in storm water and non storm water discharges during construction
- Develop a maintenance schedule for BMP installed during construction to reduce or eliminate pollutants after construction
Vicinity Map

⇒ Required text, map size
⇒ A vicinity map and site map are required. Vicinity map shows:
  - Outline of site perimeter
  - Easily identifiable major roadways
  - Geographic features or landmarks
  - Water bodies within or adjacent to the project site
  - Construction site perimeter
  -_known wells
  - Outline of offsite drainage areas discharging to the construction site
  - Discharge locations
  - General topography and geographical features surrounding the site
SWPPP Attachments

**Attachment A**

- **Vicinity Map**
  - Use a USGS map or equivalent
  - Extend approximately 400 M or one-quarter mile of project boundary
  - Show all necessary information

**Site Map**

- Include title sheet from project plans
500.3 Pollutant Source Identification and BMP Selection

⇒ 500.3.1 Inventory of materials and activities that may Pollute Storm Water
⇒ 500.3.2 Existing (pre-construction) Control Measures
⇒ 500.3.3 Nature of Fill Material and Existing Data Describing Soil
⇒ 500.3.4 Soil Stabilization
⇒ 500.3.5 Sediment Controls
⇒ 500.3.6 Tracking Controls
⇒ 500.3.7 Wind Erosion Controls
⇒ 500.3.8 Non-Storm Water Controls
⇒ 500.3.9 Waste Management and Materials Pollution Controls
Inventory of Materials and Activities that may Pollute Storm Water

⇒ Required text

⇒ List all construction materials that have the potential to contribute to the discharge of pollutants to storm water

- Vehicle fluids, including oil, grease, petroleum, and coolants
- Asphalric emulsions associated with paving operations
- Cement materials associated with PCC operations
- Joint and curing compounds
- Paints, solvents and thinners
- Wood products
- Metals and plated products
- Fertilizers, herbicides, and pesticides
500.3.1

List construction activities that may have the potential to contribute sediment to storm water discharges

- Clear and grub operations
- Grading operations
- Soil import operations
- Utility excavation operations
- Landscaping operations
- Material stockpile operations
Existing (pre-construction) Control Measures

⇒ Required text
⇒ Identify any existing control measures in place prior to construction including but not limited to:
  • Detention basins
  • Infiltration basins
  • Sediment basins
  • Oil water separators
  • Bridge and Rock slope protection
  • Existing erosion control measures
  • Existing landscaping
  • Energy dissipaters
  • Lined ditches
500.3.3

Nature of Fill Material and Existing Data describing Soil

⇒ Required text
⇒ Describe the conditions of fill material and soil on the construction site
   • Type of soil
   • Groundwater location
⇒ Show and/or describe existing site features that, as a result of past usage may contribute pollutants to storm water
   • Toxic materials
   • Aerially Deposited Lead (ADL)
Break
Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities
RE Responsibilities During Construction

Course Highlights

- Introduction
- Role of the Players
- Management Tools
- RE Responsibilities Before Construction
- RE Responsibilities During Construction
- Project Closeout Responsibilities
- Starting Construction
- Inspections
- Notice of Discharge
- Payments / Sanctions
- Annual Certification / Documentation
Starting Construction

- No work having the potential to cause water pollution can start before RE approval of the SWPPP/WPCP.

- Contractor should not:
  - Move-in equipment or pollutant causing materials,
  - Disturb soil areas, or
  - Track sediment onto adjacent roads.
Conditional Approval

⇒ After submission of a SWPPP/WPCP, the RE may allow certain construction activities to start while the revisions are incorporated.

Consider the following:

⇒ Season
⇒ Type of activity
⇒ Location of activity
RE Responsibilities During Construction

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities

⇒ Starting Construction
⇒ Inspections
⇒ Notice of Discharge
⇒ Payments / Sanctions
⇒ Annual Certification / Documentation
Inspections

Contractor

⇒ Review contractor inspection reports.

Caltrans

⇒ Inspect the contractor’s operations for water pollution control compliance
Inspections

✦ Frequency

⇒ Prior to anticipated storm events
⇒ During extended storm events (once each 24-hour period)
⇒ After actual storm events
⇒ As specified in the Special Provisions
Prior to an anticipated storm event, confirm…:

⇒ Active areas limited as specified (rainy season)
⇒ The protection of active and nonactive DSAs
⇒ The control of off-site storm water run-on
⇒ The condition of drainage systems
⇒ BMPs are properly implemented
Inspections

During a storm event:

⇒ Best time to review BMPs!

⇒ Confirm the proper functioning of BMPs.

⇒ Ensure BMPs do not cause flooding.

⇒ Repair or revise BMPs as conditions allow.

⇒ Good learning experience.
Inspections

After an actual storm event:

⇒ Identify BMPs that failed.
⇒ Identify BMPs that need maintenance.
⇒ Repair, revise and maintain BMPs as necessary.
⇒ Good learning experience.
RE Responsibilities During Construction

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities

⇒ Starting Construction
⇒ Inspections
⇒ Notice of Discharge
⇒ Payments / Sanctions
⇒ Annual Certification / Documentation
Notice Of Discharge

- Action required upon discovery of a discharge or if the project receives a written notice or order from any regulatory agency.

- Failure to report is subject to a $27,500 fine.

- See Section 9.4 of the SWMP for noncompliance reporting.
Notice Of Discharge

ู่ Applicable Discharges:

⇒ Storm water discharges that contain sediment from DSAs due to the absence of required, failed or damaged BMPs.
⇒ Prohibited non-storm water discharges.
⇒ Discharges that violate numeric prohibitions or limitations.
⇒ Discharges that violate 404 permits or 401 certifications
Notice Of Discharge

RE actions with noncompliant discharges:

⇒ If possible, cease construction activity and/or mitigate discharge impacts.
⇒ Verbally notify DCSWC.
⇒ Rectify the noncompliant condition.
⇒ Complete Notice of Discharge. Coordinate through DCSWC.

Attachment K
Notice of Discharge, Written Notice, or Order

INSTRUCTIONS

- This form will be submitted to the Resident Engineer within 7 days of the assessment of discharge, written notice, or orders from a regulatory agency.

To: Name of Caltrans Resident Engineer  Date: Insert Date
Subject: Notice of Discharge

Project Name: Insert Project Name
Caltrans Contract Number: contract number

In accordance with the Caltrans NPDES Statewide Permit for Storm Water Discharges Associated with Construction Activity, the following instance of discharge is noted:

Date, time, and location of discharge
Insert description and date of event

Nature of the operation that caused the discharge
Insert description of operation

Initial assessment of any impact cause by the discharge
Insert assessment

Existing BMP(s) in place prior to discharge event
List BMPs in place

Date of deployment and type of BMPs deployed after the discharge.
BMPs deployed after the discharge (with dates)
Notice Of Discharge

Contents:

⇒ Date, time, and location of discharge.
⇒ Nature of operation.
⇒ Assessment of impact.
⇒ The BMPs deployed before the discharge.
⇒ The BMPs deployed after the discharge.
⇒ Steps planned to reduce, eliminate and/or prevent re-occurrence.
⇒ An implementation and maintenance schedule.
RE Responsibilities During Construction

Course Highlights

- Introduction
- Role of the Players
- Management Tools
- RE Responsibilities Before Construction
- RE Responsibilities During Construction
- Project Closeout Responsibilities
- Starting Construction
- Inspections
- Notice of Discharge
- Payments / Sanctions
- Annual Certification / Documentation
Progress Payments

- Schedule of Values or specific items
- Manage SWPPP items like other contract items
- 50/50 Maintenance (New)
- Additional Move-ins (New)
Contractual Sanctions

Available negative reinforcement:

⇒ Suspending any work that would exacerbate the noncompliance or interfere with or prevent the contractor’s efforts to correct the deficiency

⇒ Withholding funds from contract progress payments as specified in the contract
Contractual Sanctions

- Available negative reinforcement:
  - Assessing liquidated damages including passing along fines for permit violations
  - Bringing in a separate contractor or Caltrans Maintenance to complete the work
  - Initiating cancellation of the Construction contract
RE Responsibilities During Construction

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities Before Construction
⇒ RE Responsibilities During Construction
⇒ Project Closeout Responsibilities

⇒ Starting Construction
⇒ Inspections
⇒ Notice of Discharge
⇒ Payments / Sanctions
⇒ Annual Certification / Documentation
Contractor to complete, sign and submit to RE.
⇒ Before June 15 of each year
⇒ RE to sign and return to contractor.
⇒ File in the project records.
⇒ $10,000 fine and/or up to 2 years imprisonment for knowingly falsifying records.

Attachment M
Annual Certification of Compliance Form

INSTRUCTIONS
- By June 15th of each year, the Contractor shall complete and submit this form to the Resident Engineer for approval as required in Section 100.3 of the SWPPP.
- Annual certification of compliance is based on the site inspections required in the SWPPP.
- Completed and signed Annual Certifications and Approvals shall be included in Section 100.3 of the SWPPP following the required text of the section.
- This Annual Certification of Compliance form does not need to be completed at the initial approval, but it shall be submitted during the first year of the initial SWPPP approval.
Contract Documentation

Category 20 files

⇒ SWPPP/WPCP
⇒ Amendments
⇒ Annual certification
⇒ Contractor inspection reports
⇒ Caltrans inspection reports
⇒ Correspondence with the contractor
⇒ SWTF inspection reports
⇒ Correspondence with regulatory agencies
Project Closeout Responsibilities

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities
  Before Construction
⇒ RE Responsibilities
  During Construction
⇒ Project Closeout
  Responsibilities
Project Closeout Responsibilities

Course Highlights

⇒ Introduction
⇒ Role of the Players
⇒ Management Tools
⇒ RE Responsibilities
  Before Construction
⇒ RE Responsibilities
  During Construction
⇒ Project Closeout Responsibilities

⇒ Maintenance Review
⇒ Relief for Maintenance
⇒ Contract Acceptance
⇒ Terminating Permit Coverage
⇒ Post-construction meeting
  with Design
⇒ Retention of Records
Maintenance Review

- Conduct at 90% complete.
- Conduct with Maintenance Superintendent/Supervisor.
- During field review, discuss:
  - Temporary BMPs to remain.
  - Permanent structural storm water BMP devices.
  - Requested field adjustments.
- Furnish information (RE Pending File) pertaining to permanent BMP devices.
Relief From Maintenance

- Construction Manual 2-07 & Standard Specifications Section 7-1.15.
- Upon request, the Contractor may be relieved from the duty of maintaining and protecting certain completed portions of the work.
- To qualify, such portions must be completed in all respects (including water pollution control) in accordance with the requirements of the contract and to the satisfaction of the Engineer.
Contract Acceptance

- Construction Manual 2-07 & Standard Specifications Section 7-1.17
- Post construction BMP devices implemented
  ⇒ Final erosion control
  ⇒ Planting and irrigation
- Temporary controls removed and disposed of
Terminating Permit Coverage

- Complete construction
- Meet final stabilization requirements
- Notice of Completion of Construction
Terminating Permit Coverage

Final Stabilization Requirements

⇒ Special Provision requirements
⇒ NPDES permit requirements

- Areas where construction has been completed in conformance with the contract plans and permanent erosion control is in place and functional.
- Erosion control is considered functional when a uniform vegetative cover equivalent to 70 percent of the native background vegetation coverage has been established or equivalent stabilization measures have been employed.
Terminating Permit Coverage

- The Notice of Completion of Construction (NCC) equivalent to the NOT.
- Only required for SWPPP projects.

Terminating Permit Coverage

Until all requirements for completion are met, the project must still comply with the permit including:

- The SWPPP must remain on site during working hours.
- Site inspections continue prior to, during, and after storm events.
- The June 15 Annual Certification of Compliance.
- Notice of Discharge reporting.
Post-Construction Meeting With Design

Lessons Learned

- Discussion of what worked and what didn’t work.
- Allows for incorporation of lessons learned into future designs.
Retention Of Records

- Retain the following records for a period of at least 3 years from the date generated:
  - Approved SWPPP documents and amendments
  - Records of all inspections
  - Compliance certifications
  - Notification of Construction
  - Notice of Discharge reporting
  - Notice of Completion of Construction
Closing Comments

⇒ The REs SWPPP responsibilities are many!
⇒ Assistance should be obtained when necessary, especially for larger projects
⇒ Resources available to you
⇒ DCSWC
⇒ Manuals - BMP / SWPPP-WPCP / Construction
⇒ Storm Water Task Force
⇒ Be proactive, not reactive!